Chapter 6: Creating a Chart
In This Chapter
✓ Looking at the different parts of a chart
✓ Creating a chart
✓ Examining the different types of charts
✓ Entering chart data in an Excel worksheet
✓ Positioning a chart in Excel, Word, and PowerPoint
✓ Changing the appearance of a chart
✓ Saving a customized chart as a template so that you can use it again
✓ Exploring some fancy-schmancy chart tricks
✓ Fixing common problems with charts

N

othing is more persuasive than a chart. The bars, pie slices, lines, or
columns show instantaneously that production is up or down, that
cats are better than dogs or dogs better than cats, or that catsup tastes
better than ketchup. Fans of charts and graphs will be glad to know that putting a chart in a Word document, Excel worksheet, or PowerPoint slide is
fairly easy.
This chapter explains how to create a chart. It looks at which charts are
best for presenting different kinds of data, how to change a chart’s appearance, and how to save charts in a template that you can use again. You
discover some nice chart tricks, including how to make a picture the backdrop for a chart and how to annotate a chart. This chapter also addresses
common chart problems.

A Mercifully Brief Anatomy Lesson
Throughout this chapter, I show you many ways to tinker with charts, but
before you can begin tinkering, you need to know what you’re tinkering
with. In other words, you have to know what the different parts of a chart
are. Here is a brief chart anatomy lesson. Figure 6-1 points out where some
of the terms described here are found on a real, live chart:
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✦ Plot area: The center of the chart, apart from the legend and data labels,
where the data itself is presented.
✦ Values: The numerical values with which the chart is plotted. The values
you enter determine the size of the data markers — the bars, columns,
pie slices, and so on — that portray values. In the column chart in Figure
6-1, values determine the height of the columns.
✦ Gridlines: Lines on the chart that indicate value measurements.
Gridlines are optional in charts (none are shown in Figure 6-1).
✦ Worksheet: Where you enter (or retrieve) the data used to plot the
chart. The worksheet resembles a table. Figure 6-2 shows the worksheet
I used to enter the data that produced the chart in Figure 6-1. Notice
how the numbers at the top of the columns correspond to the numbers
entered in the worksheet shown in Figure 6-2. A worksheet is called a
data table when it appears along with a chart.

Values

Data series

Plot area Data labels Legend

Figure 6-1:
The different
parts of
a chart
(which was
generated
from the
worksheet
in Figure 6-2).

Categories

Figure 6-2:
The
information
entered
in this
worksheet
produced
the chart
shown in
Figure 6-1.
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✦ Data series: A group of related data points presented by category on a
chart. The chart in Figure 6-1 has two data series, one for Texas and one
for Utah.

✦ Legend: A text box located to the side, top, or bottom of a chart that
identifies the chart’s data labels.

Creating a Chart

✦ Categories: The actual items that you want to compare or display in
your chart. In Figure 6-1, the categories are the three years in which UFO
sightings occurred in the two states.
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✦ Horizontal and vertical axes: For plotting purposes, one side of the plot
area. In the chart in Figure 6-1, UFO sightings are plotted on the horizontal axis; categories are plotted on the vertical axis. Sometimes these axes
are called the category axis (or x axis) and the value axis (or y axis).
Axes can be confusing, but these axes aren’t as evil as they seem. All you
really need to know about them is this: You can label the axes in different ways and you can rotate the chart so that the horizontal becomes
the vertical axis and vice versa (click the Switch Row/Column button).
✦ Data point: A value plotted on a chart that is represented by a column,
line, bar, pie slice, dot, or other shape. Each data point corresponds to
a value entered in the worksheet. In Figure 6-1, for example, the data
points for Texas UFO sightings are 14 in 2005, 11 in 2006, and 9 in 2007.
Hence the Texas columns in the table rise to the 14, 11, and 9 level.
✦ Data marker: Shapes on a chart that represent data points. Data markers include columns, lines, pie slices, bubbles, and dots. In Figure 6-1,
columns are the data markers.
✦ Data label: A label that shows the actual values used to construct the
data markers. In the chart in Figure 6-1, there are six data labels, one on
the top of each column. Displaying data labels in charts is optional.
The good news where the anatomy of a chart is concerned is that you can
click anywhere on a chart and see a pop-up box that tells you what part of
the chart you just clicked. I wish biology class were that easy!

The Basics: Creating a Chart
Throughout this chapter, I explain the whys, wherefores, and whatnots
of creating a chart. Before going into details, here are the basic steps that
everyone needs to know to create a chart in Word, Excel, and PowerPoint:

1. Go to the Insert tab.
2. If you’re working in Excel, select the data you’ll use to generate the
chart (in Word and PowerPoint, skip to Step 3).
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In Excel, you select the data on a worksheet before creating the chart,
but in Word and PowerPoint, you enter the data for the chart in Excel in
Step 4. Yes, you heard me right — in Word and PowerPoint. Excel opens
after you begin creating your chart so you can enter data for the chart in
an Excel worksheet.

3. Select the kind of chart you want.
How you select a chart type depends on which program you’re
working in:
• Excel: Either open the drop-down list in one of buttons in the Chart
group on the Insert tab (Column, Line, Pie, Bar, Area, Scatter, or
Other Charts) and select a chart type, or click the Charts group
button to open the Insert Chart dialog box and select a chart there.
As shown in Figure 6-3, the Insert Chart dialog box shows all the
kinds of charts you can create.
• Word and PowerPoint: Click the Chart button. You see the Insert
Chart dialog box shown in Figure 6-3. Select a chart and click OK. The
Excel program opens on the right side of your computer screen. (In
PowerPoint, you can also click the Chart icon on a placeholder frame
to open the Insert Chart dialog box.)
The next portion of this chapter, “Choosing the Right Chart,” describes
all the charts types and advises you which to choose.

Chart type

Chart variations

Figure 6-3:
Which chart
do you
want?
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4. In Word and PowerPoint, replace the sample data in the Excel worksheet with the data you need for generating your chart.

5. To modify your chart, start by selecting it.
Click a chart to select it. Selecting a chart makes the Chart Tools tabs
appear in the upper-right corner of the window. Use these tabs —
Design, Layout, and Format — to make your chart just-so.

Creating a Chart

Later in this chapter, “Providing the Raw Data for Your Chart” explains
how to enter data in an Excel worksheet. After you finish entering the
data, you can close Excel by clicking the Close button in the Excel
window or going to the File tab and choosing Close.
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In Word, you must be in Print Layout view to see a chart.

6. Select the (Chart Tools) Design tab when you want to change the
chart’s layout, alter the data with which the chart was generated, or
select a different chart type.
Later in this chapter, “Changing a Chart’s Appearance” explains how to
change the design of a chart.

7. Select the (Chart Tools) Layout tab when you want to change the
chart’s title, labels, or gridlines.
You can add or remove parts of a chart starting on the Layout tab.
Later in this chapter, “Changing the layout of a chart” describes how to
change around the text and gridlines on a chart.

8. Select the (Chart Tools) Format tab when you want to change the
appearance of your chart.
You can change colors and fills on your chart, as “Changing a chart element’s color, font, or other particular” explains later in this chapter.
And if you decide to delete the chart you created? Click its perimeter to
select it and then press the Delete key.

Choosing the Right Chart
If you’re a fan of charts, the huge selection of charts can make you feel like a
kid in a candy store, but if charts aren’t your forte, the wealth of charts you
can choose from can be daunting. You can choose among 6 dozen charts in
11 categories (refer to Figure 6-3). Which chart is best? The golden rule for
choosing a chart type is to choose the one that presents information in the
brightest possible light. The purpose of a chart is to compare information
across different categories. Select a chart that draws out the comparison so
that others can clearly make comparisons. Table 6-1 describes the 11 chart
categories and explains in brief when to use each type of chart.
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Table 6-1
Symbol
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Chart Types

Chart Type

Best Use/Description

Area

Examine how values in different categories fluctuate over
time, and see the cumulative change in values. (Same as
a line chart except that the area between trend lines is
colored in.)

Bar

Compare values in different categories against one another,
usually over time. Data is displayed in horizontal bars. (Same
as a column chart except that the bars are horizontal.)

Bubble

Examine data relationships by studying the size and location of the bubbles that represent the relationships. Bubble
charts are often used in financial analyses and market
research. (Similar to an XY scatter chart except that you can
use three rather than two data series, and the data points
appear as bubbles.)

Column

Compare values in different categories against one another,
usually over time. Data is displayed in vertical columns.
(Same as a bar chart except that the bars are vertical.)

Doughnut

See how values compare as percentages of a whole.
(Similar to a pie chart except that you can use more than
one data series and create concentric doughnut rings in
the chart.)

Line

Examine how values fluctuate over time. Data is displayed in
a set of points connected by a line.

Pie

See how values compare as percentages of a whole. Data
from categories is displayed as a percentage of a whole.
(Similar to a doughnut chart.)

Radar

Examine data as it relates to one central point. Data is plotted on radial points from the central point. This kind of chart
is used to make subjective performance analyses.

XY
(Scatter)

Compare different numeric data point sets in space to reveal
patterns and trends in data. (Similar to a bubble chart except
that the data appears as points rather than bubbles.)

Stock

See how the value of an item fluctuates, as well as its daily,
weekly, or yearly high, low, and closing price. This chart is
used to track stock prices, but it can also be used to track
air temperature and other variable quantities.

Surface

Examine color-coded data on a 3-D surface to explore relationships between data values.
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Providing the Raw Data for Your Chart

Creating a Chart

Every chart is constructed from raw data — the numbers and category
names you select in an Excel worksheet (in Excel) or enter in an Excel worksheet (in Word and PowerPoint). If you’re operating in Word or PowerPoint,
you see, in the Excel worksheet, sample data in a data range. The information inside the data range is used to generate the chart. You can tell where
the data range begins and ends because it is enclosed in a blue border. Your
job is to replace the sample data in the data range with data of your own. As
you enter your data, the chart on your slide or page takes shape.

Book I
Chapter 6

Book V, Chapter 1 explains in detail how to enter data in an Excel worksheet,
but here are the basics of entering data in case you’re new to Excel:
✦ Entering the data in a cell: A cell is the box in a worksheet where a
column and row intersect; each cell can contain one data item. To
enter data in a cell, click the cell and start typing. When you’re finished,
press Enter, press Tab, or click a different cell. You can also click in the
Formula bar (above the worksheet) and enter the data there.
✦ Deleting the data in a cell: To delete the data in a cell, including the
sample data Excel provides for charts, click the cell and press Delete.
✦ Displaying the numbers: When a number is too large to fit in a cell,
Excel displays pound signs (###) or displays the number in scientific
notation. Don’t worry — the number is still recorded and is used to
generate your chart. You can display large numbers by widening the
columns in which the numbers are found. Move the pointer between
column letters (A, B, and so on at the top of the worksheet) and when
you see the double-headed arrow, click and drag to the right.
To enclose more or fewer cells in the data range, move the pointer to the
lower-right corner of the data range, and when the pointer changes into a
two-headed arrow, click and drag so that the blue box encloses only the data
you want for your chart.
In Word and PowerPoint, click the Edit Data button on the (Chart Tools)
Design tab at any time to open Excel and fiddle with the numbers and data
from which your chart is generated.

Positioning Your Chart in a Workbook, Page, or Slide
To change the position of a chart, click to select it, click its perimeter, and
when you see the four-headed arrow, start dragging. Otherwise, follow these
instructions to land your chart where you want it to be:
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✦ Excel: To move your chart to a different worksheet or create a new
worksheet to hold your chart, go to the (Chart Tools) Design tab and
click the Move Chart button. You see the Move Chart dialog box.
• To move your chart to a different worksheet, click the Object In
option button, choose the worksheet in the drop-down list, and
click OK.
• To create a new worksheet for a chart, click the New Sheet option
button, enter a name for the new worksheet, and click OK.
✦ Word: Starting in Print Layout view, select your chart, and in the Page
Layout or (Chart Tools) Format tab, click the Position button (you may
have to click the Arrange button first, depending on the size of your
screen). You see a drop-down list with text-wrapping options. Choose
the option that describes how you want surrounding text to behave
when it crashes into your chart. Book II, Chapter 4 looks in detail at
wrapping text around charts and other objects in Word.
✦ PowerPoint: Select the chart and drag it on the slide to the right position.

Changing a Chart’s Appearance
Charts are awfully nice already, but perhaps you want to redesign one.
Perhaps you’re an interior decorator type and you want to give charts your
own personal touch. Excel, PowerPoint, and Word offer these Chart Tools
tabs for redecorating charts:
✦ Design tab: For quickly changing a chart’s appearance. Go to the Design
tab if you’re in a hurry. The ready-made gallery choices give you the
opportunity to change a chart’s layout and appearance in a matter of
seconds. You can also choose a new chart type from the Design tab. See
“Relying on a chart style to change appearances,” later in this chapter.
✦ Layout tab: For rearranging, hiding, and displaying various parts of a
chart, including the legend, labels, title, gridlines, and scale. Go to the
Layout tab to tweak your chart and make different parts of it stand out
or recede into the background. For example, you can display axis labels
more prominently or make them disappear, enter a title for your chart,
or display more or fewer gridlines. See “Changing the layout of a chart”
and “Handling the gridlines,” later in this chapter.
✦ Format tab: For changing the color, outline, font, and font size of various
parts of a chart, including the labels, bars, and pie slices. You have to
really know what you’re doing and have a lot of time on your hands to
change colors and fonts throughout a chart. See “Changing a chart element’s color, font, or other particular,” later in this chapter.
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These pages explain how to change a chart’s appearance, starting with the
biggest change you can make — exchanging one type of chart for another.

The biggest way to overhaul a chart is to ditch it in favor of a different chart
type. Luckily for you, Office makes this task simple. I wish that changing jobs
were this easy. Follow these steps to change a pumpkin into a carriage or an
existing chart into a different kind of chart:

Creating a Chart

Changing the chart type

Book I
Chapter 6

1. Click your chart to select it.
2. On the (Chart Tools) Design tab, click the Change Chart Type button,
or right-click your chart and choose Change Chart Type on the shortcut menu.
The Change Chart Type dialog box appears. Does it look familiar? This is
the same dialog box you used to create your chart in the first place.

3. Select a new chart type and click OK.
Not all chart types can be converted successfully to other chart types.
You may well have created a monster, in which case go back to Step 1
and start all over or click the Undo button.

Changing the size and shape of a chart
To make a chart taller or wider, follow these instructions:
✦ Click the perimeter of the chart to select it and then drag a handle on
the side to make it wider, or a handle on the top or bottom to make it
taller.
✦ Go to the (Chart Tools) Format tab and enter measurements in the
Shape Height and Shape Width boxes. You can find these boxes in the
Size group (you may have to click the Size button to see them, depending on the size of your screen).

Relying on a chart style to change appearances
The easiest way to change the look of a chart is to choose an option in the
Chart Styles gallery in the (Chart Tools) Design tab, as shown in Figure 6-4.
You can choose among 50 options. These gallery options are quite sophisticated. You would have a hard time fashioning these charts on your own.
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Select a Chart style

Figure 6-4:
Redesign
your chart
in the Chart
Styles
gallery.

If your file includes more than one chart, make the charts consistent with
one another. Give them a similar appearance so that your file doesn’t turn
into a chart fashion show. You can make charts consistent with one another
by choosing similar options for charts in the Chart Styles gallery.

Changing the layout of a chart
Figure 6-5 identifies the chart elements that you can lay out in different
ways. Some of these elements can be removed as well as placed on different
parts of a chart. For example, you can display the legend on any side of a
chart or not display it at all. Some of the elements can be labeled in different
ways. To decide on the layout of a chart, select it and visit the (Chart Tools)
Layout tab.
The following pages explain how to change the layout of a chart starting on
the (Chart Tools) Layout tab. However, before hurrying to the Layout tab to
change your chart’s layout, you may consider taking a detour to the (Chart
Tools) Design tab (refer to Figure 6-4). The Chart Layouts gallery on the
Design tab offers ten ready-made layouts, one of which may meet your high
expectations and spare you a trip to the Layout tab.
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Legend
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Figure 6-5:
The layout
elements of
a chart.

Vertical axis labels

Horizontal axis title

Horizontal axis labels Data labels

Deciding where chart elements appear and how they are labeled
On the (Chart Tools) Layout tab, open the drop-down list on these buttons and choose options to determine how and whether chart elements are
labeled:
✦ Chart Title: The chart title appears above the chart and describes what
the chart is about (refer to Figure 6-5). Place a centered title inside or
above the chart. The Above Chart option shrinks the chart a bit to make
room for the title. Click in the text box and enter the title after Office creates a chart title text box.
✦ Axis Titles: Axis titles list the series name and category name of the data
being plotted in the chart (refer to Figure 6-5). You can select Rotated
Title for the vertical axis to make the axis label read vertically rather
than horizontally (refer to Figure 6-5).
✦ Legend: The legend is the box to the side, top, or bottom of the chart
that describes what is being plotted (refer to Figure 6-5). Choose an
option from the drop-down list to place the chart’s legend above, below,
or to the side of a chart.
✦ Data Labels: Data labels show the numeric values by which the data
markers — the bars, columns, pie slices, or dots — in your chart are
constructed (refer to Figure 6-5). For example, if a bar in your chart represents the number 28, the data label 28 appears in the bar. You can also
label the series name or category name by choosing More Data Label
Options on the drop-down list and making selections in the Format Data
Labels dialog box.
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✦ Axes: The axes labels are the series names and scale markers that
appear in the chart. Choose Primary Horizontal Axis or Primary Vertical
Axis and then select None to remove series names and scale markers
from your chart. The other axes options are for deciding how to display
axes labels (and are explained in the next section of this chapter).

Deciding how the chart’s scale and axes labels are presented
The labels and scale on the horizontal and vertical axes of a chart tell viewers what is being plotted on the chart (refer to Figure 6-5). By clicking the
Axes button on the (Chart Tools) Layout tab, you can fine-tune the axes
labels and scale on your chart.
After you click the Axes button, you see options for changing around your
chart’s horizontal or vertical axis. What the horizontal and vertical axis
options are depends on whether the axis you’re dealing with presents text
labels, expresses numerical values, or expresses date values.

Text axis options
Choose a text axis option on the drop-down list to remove the labels or present category name labels in reverse order from the way in which these labels
are listed on the worksheet.

Numerical and date axis options
The axis options that pertain to numbers and dates are for declaring how to
present the scale on your chart. You can present the numbers in thousands,
millions, billions, or with a log scale. By opening the Format Axis dialog box
shown in Figure 6-6, you can get quite specific about how the scale is presented on your chart. To open this dialog box, click the Axes button, select
the appropriate axis option on the drop-down list, and choose More Options
on the submenu. Which options you see in this dialog box depends greatly
on which chart type you’re dealing with.
The Format Axis dialog box offers these opportunities for changing around
the scale of a chart:
✦ Changing the scale’s range: By default, the scale ranges from 0 to 10
percent more than the largest value being plotted, but you can change
the scale’s range by selecting a Fixed option button and entering a new
value in the Minimum and Maximum text box.
✦ Changing the number of unit measurement labels: Label measurements (and gridlines) appear at intervals on a chart according to the
number entered in the Major Unit text box. For example, an entry of 10
tells Office to mark each 10 units with a measurement label. Select the
Fixed option button and change the number in the Major Unit text box
to draw fewer or more unit labels (and gridlines) on your chart. If your
chart displays minor tick marks, do the same in the Minor Unit text box.
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Figure 6-6:
Fashion a
numerical
scale for a
chart in the
Format Axis
dialog box.

✦ Displaying numbers as thousandths, millionths, or billionths: If your
chart presents large numbers, consider listing these numbers in thousandths, millionths, or billionths by selecting an option in the Display
Units drop-down list. You can also select the Logarithmic Scale check
box to display numbers as logarithms.
✦ Changing the tick-mark scale markers: Choose Tick Mark options to tell
Office where or whether to place tick marks — small unit markers — on
the scale.
✦ Changing the location of axis labels: Choose an option in the Axis Labels
drop-down list to tell Office where to place the unit labels on the scale.
✦ Change the axis crosses: Select the Axis Value option button and enter
a measurement in the Axis Value text box if you want to change the
baseline of your chart. Usually, the axis value is set to 0, and markers
rise from 0 on the chart; but by entering a different measurement, you
can make markers rise or fall from the baseline. For example, if the Axis
Value baseline is 5, markers less than 5 fall from a baseline in the middle
of the chart and markers greater than 5 rise above it.

Handling the gridlines
Gridlines are lines that cross a chart and indicate value measurements. Most
charts include major gridlines to show where bars or columns meet or surpass a major unit of measurement, and you can also include fainter, minor
gridlines that mark less significant measurements. Figure 6-7 shows a chart
with gridlines displayed in different ways.
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Figure 6-7:
Options for
handling
gridlines
(clockwise
from upper
left): None,
Major
Gridlines,
Major &
Minor
Gridlines,
and Minor
Gridlines.

Select your chart and follow these instructions to hide or display gridlines,
change the lines’ width, or change the lines’ color:
✦ Hiding and choosing the frequency of gridlines: On the (Chart Tools)
Layout tab, click the Gridlines button, choose Primary Horizontal
Gridlines or Primary Vertical Gridlines on the drop-down list, and choose
an option on the submenu. You can hide gridlines (by choosing None),
display major gridlines, display minor gridlines, or display major and
minor gridlines (refer to Figure 6-7).
The frequency of gridlines on a chart is tied to the scale. If you want to
control the frequency of the gridlines on your own without relying on
a Gridlines option, change your chart’s scale. The preceding section in
this chapter explains how to handle scales.
✦ Changing gridline width: On the (Chart Tools) Format tab, open the
Chart Elements drop-down list and choose Axis Major Gridlines or Axis
Minor Gridlines (display gridlines on your chart if you don’t see these
options). Then click the Format Selection button, and in the Line Style
category of the Format Gridlines dialog box, enter a measurement in the
Width text box to make the gridlines heavier or thinner.
✦ Changing gridline color: On the (Chart Tools) Format tab, open the
Chart Elements drop-down list and select Axis Major Gridlines or Axis
Minor Gridlines. (Display gridlines on your chart if you don’t see these
options.) Then open the drop-down list on the Shape Outline button and
choose a color. You can also click the Format Selection button, and in
the Line Color category of the Format Gridlines dialog box, select the
Solid Line option button and then click the Color button and choose a
color there.
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Gridlines are essential for helping read charts, but be very, very careful
about displaying minor gridlines on charts. These lines can make your chart
unreadable. They can turn a perfectly good chart into a gaudy pinstripe suit.

Generally speaking, the (Chart Tools) Format tab is the place to go to
change the color, line width, font, or font size of a chart element. As I explain
shortly, you can do some interior decorating tasks on the (Chart Tools)
Layout tab as well.

Creating a Chart

Changing a chart element’s color,
font, or other particular
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Follow these basic steps to change a color, line width, font, or font size in
part of a chart:

1. Select the (Chart Tools) Format tab.
The tools on the (Chart Tools) Format tab are very similar to the tools
found on the (Drawing Tools) Format tab. You can find all the tools
you need here to change the color, outline, and size of a chart element.
These tools are explained in detail in Book I, Chapter 8.

2. Select the chart element that needs a facelift.
To select a chart element, either click it or choose its name on the Chart
Elements drop-down list, as shown in Figure 6-8. You can find this list in
the upper-left corner of the window.

3. Format the chart element you selected.
Use one of these techniques to format the chart element:
• Open a Format dialog box. Click the Format Selection button to open
a Format dialog box. The dialog box offers commands for formatting
the element you selected.
• Do the work on your own. Format the chart element as you would
any object. For example, to change fonts in the chart element you
selected, right-click and choose a font on the shortcut menu. Or go
to the Home tab to change font sizes. Or open the drop-down list on
the Shape Fill button on the (Chart Tools) Format tab and select a
new color.
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Select a chart element so that you can format it

Figure 6-8:
Choose
what you
want to
format on
the Chart
Elements
drop-down
list.

The (Chart Tools) Layout tab also offers these convenient commands for
changing the color of a chart element:
✦ Plot area: The plot area is the rectangle in which the chart’s gridlines, bars,
columns, pie slices, or lines appear. In some chart designs, the plot area is
filled with color. To remove this color or choose a different color, click the
Plot Area button and choose an option. Choose More Plot Area Options to
open the Format Plot Area dialog box and select a new fill color.
✦ 3-D chart wall and chart floor: Three-dimensional charts have chart walls
and a chart floor. The chart wall forms the backdrop of a 3-D chart; the chart
floor forms the bottom of the chart. Click the Chart Wall button and choose
an option to remove the chart wall or change its color; click the Chart Floor
button and choose an option to remove the chart floor or change its color.

Saving a Chart as a Template So
That You Can Use It Again
If you go to the significant trouble of redecorating a chart and you expect to
do it again the same way in the future, save your chart as a template. This
way, you can call on the template in the future to create the same chart
and not have to decorate it again. Perhaps you’ve created charts with your
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company’s colors or you’ve created a chart that you’re especially proud of.
Save it as a template to spare yourself the work of reconstructing it.

Saving a chart as a template
Follow these steps to make a template out of a chart:

Creating a Chart

A chart template holds data series colors, gridline settings, plot area colors, font
settings, and the like. It doesn’t hold data. These pages explain how to save a
chart as a template and how to create a chart with a template you created.
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1. Save your file to make sure that the chart settings are saved on your
computer.

2. Select your chart.
3. Go to the (Chart Tools) Design tab.
4. Click the Save As Template button.
You can find this button in the Type group. You see the Save Chart
Template dialog box.

5. Enter a descriptive name for the template and click the Save button.
Include the type of chart you’re dealing with in the name. This will help
you understand which template you’re selecting when the time comes to
choose a chart template.
By default, chart templates are saved in this folder in Windows 7 and
Windows Vista: C:\Users\Username\AppData\Roaming\Microsoft\
Templates\Charts. Chart templates are stored in this folder in Windows
XP: C:\Documents and Settings\Username\Application Data\
Microsoft\Templates\Charts. The templates have the .ctrx extension. If you want to delete or rename a template, open the Charts folder
in Windows Explorer or Computer and do your deleting and renaming
there. You can open the Charts folder very quickly by clicking the Manage
Templates button in the Insert Chart dialog box (refer to Figure 6-3).

Creating a chart from a template
To create a chart from your own customized template, open the Create
Chart dialog box (click the Chart button) and go to the Templates category.
The dialog box shows a list of templates you created. Move the pointer over
a template to read its name in a pop-up box. Select a template and click OK.

Chart Tricks for the Daring and Heroic
This chapter wouldn’t be complete without a handful of chart tricks to
impress your friends and intimidate your enemies. In the pages that follow,
you discover how to make charts roll over and play dead. You also find out
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how to decorate a chart with a picture, annotate a chart, display worksheet
data alongside a chart, and create an overlay chart.

Decorating a chart with a picture
As shown in Figure 6-9, a picture looks mighty nice on the plot area of a
chart — especially a column chart. If you have a picture in your computer
that would serve well to decorate a chart, you are hereby encouraged to start
decorating. Follow these steps to place a picture in the plot area of a chart:

1. Select your chart.
2. On the (Chart Tools) Format tab, open the Chart Elements drop-down
list and choose Plot Area.

3. Click the Shape Fill button and choose Picture on the drop-down list.
You see the Insert Picture dialog box.

4. Locate the picture you need and select it.
Try to select a light-colored picture that will serve as a background.
Book VIII, Chapter 3 explains how you can recolor a picture to make it
lighter.

5. Click the Insert button.
The picture lands in your chart.
You may need to change the color of the data markers — the columns,
bars, lines, or pie slices — on your chart to make them stand out against
the picture. See “Changing a chart element’s color, font, or other particular,” earlier in this chapter.

Figure 6-9:
Using a
picture
as the
backdrop of
a chart.
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Annotating a chart

Creating a Chart

To highlight part of a chart — an especially large pie slice, a tall column, or a
bar showing miniscule sales figures — annotate it with a callout text box and
place the text box beside the pie slice, column, or bar. Figure 6-10 shows an
example of an annotated chart. The annotation tells you that one sector isn’t
performing especially well and somebody ought to get on the ball.
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Figure 6-10:
Annotations
point out
a chart’s
salient
features.

To annotate a chart, select a callout shape, enter text in the callout shape,
and connect the shape to part of your chart. Follow these steps to annotate
a chart:

1. Select your chart and go to the (Chart Tools) Layout tab.
2. Click the Shapes button, scroll to the Callouts section of the dropdown list, and choose a callout.
Depending on the size of your screen, you may have to click the Insert
button to get to the Shapes button.

3. Drag on your slide to draw the callout shape.
Book I, Chapter 8 explains drawing shapes in gory detail.

4. Type the annotation inside the callout shape.
5. Resize the callout shape as necessary to make it fit with the chart.
6. Drag the yellow diamond on the callout shape to attach the callout to
the chart.
You probably have to do some interior decorating to make the callout
color fit with the chart. Book I, Chapter 8 explains how to change an
object’s color.
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Displaying the raw data alongside the chart
Showing the worksheet data used to produce a chart is sort of like showing
the cops your ID. It proves you’re the real thing. It makes your chart more
authentic. If yours is a simple pie chart or other chart that wasn’t generated
with a large amount of raw data, you can display the data alongside your
chart in a data table. Anyone who sees the table knows you’re not kidding or
fudging the numbers.
Select your chart and use of one of these techniques to place a table with the
raw data below your chart:
✦ On the (Chart Tools) Layout tab, click the Data Table button and choose
an option on the drop-down list.
✦ On the (Chart Tools) Design tab, open the Chart Layouts gallery and
select a layout that includes a data table.
To format a data table, go to the (Chart Tools) Format tab, open the Chart
Element drop-down list and choose Data Table. Then click the Format
Selection button. You see the Format Data Table dialog box, where you can
fill the table with color and choose colors for the lines in the table.

Creating an overlay chart
An overlay chart is a secondary chart that appears over another chart, the
idea being to contrast two sets of data. Create an overlay chart by selecting
one data series in a chart you already created and instructing Office to use
the data in the series for the overlay chart. To create an overlay chart, the
original chart must plot more than one data series. Figure 6-11 shows a bar
chart overlaying a stacked area chart.

Figure 6-11:
An overlay
chart, in
this case a
bar chart
overlaying
a stacked
area chart.
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Follow these steps to create an overlay chart:

1. In a chart you created, click to select the data series that you will use
The easiest way to select a data series is to click the chart itself, but you
can also go to the (Chart Tools) Format tab and select a series in the
Chart Elements drop-down list.

2. Right-click the data series you selected and choose Change Series
Chart Type.

Creating a Chart

to create the secondary chart.
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You see the Change Chart Type dialog box.

3. Choose a chart type for the overlay chart and click OK.
Be sure to click a chart type different from the one in the other chart.

Placing a trendline on a chart
Especially on column charts, a trendline can help viewers more clearly see
changes in data. Viewers can see, for example, that sales are going up or
down, income is rising or falling, or annual rainfall is increasing or decreasing. Figure 6-12 shows an example of a trendline on a chart. In this case, the
trendline shows that the deer population in Sacramento County is rising.

Figure 6-12:
A trendline
helps
viewers
recognize
changes in
data.

Follow these steps to put a trendline on a chart:

1. On the (Chart Tools) Layout tab, open the Chart Elements drop-down
list and choose the data series that you want to highlight with a
trendline.

10_497487-bk01ch06.indd 121

3/25/10 8:35 PM

122

Troubleshooting a Chart
2. Click the Trendline button and choose a trendline option on the dropdown list.
You can choose More Trendline Options on the drop-down list to open the
Format Trendline dialog box and choose additional types of trendlines.
To change the look of a trendline, right-click it and choose Format
Trendline. In the Format Trendline dialog box, choose a line color and
line style.
To remove a trendline from a chart, go to the (Chart Tools) Layout tab, click
the Trendline button, and choose None on the drop-down list.

Troubleshooting a Chart
Sometimes tinkering with a chart opens a Pandora’s box of problems. You
find yourself having to correct little errors that appear in charts. Here are
some shorthand instructions for fixing common chart problems:
✦ The dates in the chart aren’t formatted right. To change the way in
which dates are formatted on a chart, go to the (Chart Tools) Format
tab, open the Chart Elements drop-down list, and choose Horizontal
(Value) Axis or Vertical (Value) Axis. Then click the Format Selection
button, and in the Format Axis dialog box, go to the Number category,
select Date in the Category menu, and choose a date format.
✦ The numbers in the chart aren’t formatted right. To change the
number of decimal places, include comma separators in numbers, display currency symbols, or do all else that pertains to numbers, go to the
(Chart Tools) Format tab, open the Chart Elements drop-down list, and
choose Horizontal (Value) Axis or Vertical (Value) Axis. Then click the
Format Selection button. You see the Format Axis dialog box. Visit the
Number category and select options for displaying numbers.
✦ “Category 1” or “Series 1” appears in the chart legend. To direct you
to the right place to enter data in Excel worksheets, phantom names
such as “Category 1” and “Series 1” appear in worksheets. Sometimes
these phantoms wind up in chart legends as well. To remove them, go
to the (Chart Tools) Design tab and click the Edit Data button. You see
the Excel worksheet, where the data range used to generate the chart is
enclosed in a blue box. Drag the lower-right corner of the box so that the
box encloses only the data you want for your chart.
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✦ The chart doesn’t gather all data from the worksheet. On the (Chart
Tools) Design tab, click the Edit Data button, and in the Excel worksheet
that stores data for your chart, enlarge the blue data-range box so that
it encloses all your data. You can enlarge the box by dragging its lowerright corner.
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Creating a Chart

✦ In 3-D charts, small markers are obscured by large markers in the
foreground. For all the data markers to be shown in a 3-D chart, the
smaller ones have to be in the foreground. To rearrange data markers,
go to the (Chart Tools) Design tab and click the Select Data button to
open the Select Data Source dialog box. Then select a series and click
the Up or Down button to rearrange the series in your chart. Series that
are high on the list go to the back of the chart; series that are low on the
list go to the front.

✦ The scale is too big for my chart. Especially if the scale range on a
chart is small, the scale can be too big compared to the data markers.
To change the scale range, go to the (Chart Tools) Layout tab, click the
Axes button, choose the appropriate axis option on the drop-down list,
and choose More Options. Then, in the Format Axis dialog box, select
the Fixed option button and enter a Maximum value to establish the
top of the scale for your chart. For more details, see “Deciding how the
chart’s scale and axes labels are presented,” earlier in this chapter.
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